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Legal Notices

Warranty

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an 
additional warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 
commercial license.

Copyright Notices

© Copyright 2001-2014 Hewlett-Packard Development Company, L.P.

Trademark Notices

Adobe® is a trademark of Adobe Systems Incorporated.

Intel® and Itanium® are trademarks of Intel Corporation in the U.S. and other countries.

Microsoft®, Windows®‚ Windows® XP are U.S. registered trademarks of Microsoft Corporation.

Oracle and Java are registered trademarks of Oracle and/or its affiliates.

UNIX® is a registered trademark of The Open Group.

Support

Visit the HP Software Support Online website at:

http://www.hp.com/go/hpsoftwaresupport 

This website provides contact information and details about the products, services, and support that HP 
Software offers. 

HP Software online support provides customer self-solve capabilities. It provides a fast and efficient way 
to access interactive technical support tools needed to manage your business. As a valued support 
customer, you can benefit by using the support website to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training
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Most of the support areas require that you register as an HP Passport user and sign in. Many also require a 
support contract. To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html

To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp

Support Matrices

For complete support and compatibility information, see the support matrix for the relevant product 
release. All support matrices and product manuals are available here on the HP Software Support Online 
website:

http://h20230.www2.hp.com/sc/support_matrices.jsp

You can also download the HP Server Automation Support and Compatibility Matrix for this release from 
the HP Software Support Online Product Manuals website:

http://h20230.www2.hp.com/selfsolve/manuals

Documentation Updates

All the latest Server Automation product documentation for this release is available from the SA 
Documentation Library:

http://support.openview.hp.com/selfsolve/document/KM00417675/binary/
SA_10_docLibrary.html

Use the SA Documentation Library to access any of the guides, release notes, support matrices, and white 
papers relevant to this release or to download the full documentation set as a bundle. The SA 
Documentation Library is updated in each release and whenever the release notes are updated or a new 
white paper is introduced.

How to Find Information Resources

You can access the information resources for Server Automation using any of the following methods:

Method 1: Access the latest individual documents by title and version with the new SA Documentation 
Library

Method 2: Use the complete documentation set in a local directory with All Manuals Downloads

Method 3: Search for any HP product document in any supported release on the HP Software 
Documentation Portal

To access individual documents:

1 Go to the SA 10.x Documentation Library: 

http://support.openview.hp.com/selfsolve/document/KM00417675/binary/
SA_10_docLibrary.html  

2 Log in using your HP Passport credentials.

3 Locate the document title and version that you want, and then click go.
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To use the complete documentation set in a local directory:

1 To download the complete documentation set to a local directory:

a Go to the SA Documentation Library: 

http://support.openview.hp.com/selfsolve/document/KM00417675/
binary/SA_10_docLibrary.html  

b Log in using your HP Passport credentials.

c Locate the All Manuals Download title for the SA 10.1 version.

d Click the go link to download the ZIP file to a local directory.

e Unzip the file.

2 To locate a document in the local directory, use the Documentation Catalog (docCatalog.html), which 
provides an indexed portal to the downloaded documents in your local directory.

3 To search for a keyword across all documents in the documentation set:

a Open any PDF document in the local directory.

b Select Edit > Advanced Search (or Shift+Ctrl_F).

c Select the All PDF Documents option and browse for the local directory.

d Enter your keyword and click Search.

To find additional documents on the HP Software Documentation Portal:

Go to the HP Software Documentation Portal:

http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign in. To register for an HP Passport ID, click 
the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support service. 
Contact your HP sales representative for details. See Documentation Change Notes for a list of any 
revisions.

Product Editions

There are two editions of Server Automation:

• Server Automation (SA) is the Ultimate Edition of Server Automation. For information about Server 
Automation, see the SA Release Notes and the SA User Guide: Server Automation.

• Server Automation Virtual Appliance (SAVA) is the Premium Edition of Server Automation. For more 
information about what SAVA includes, see the SAVA Release Notes and the SAVA at a Glance Guide. 
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1 Introduction
Storage Essentials (SE) version 6.1.1 and later is required to view, report, or perform any Service 
Automation Visualizer (SAV) and Service Automation Reporter (SAR) operation on SAN objects, such as 
arrays, switches, volumes, and so on. SAN objects are discovered in Storage Essentials. To enable 
discovered SAN objects in the SA, SAV, and SAR products, the Server Automation SE Connector component 
must be installed and configured. 

The following storage components for Storage Visibility and Automation must be installed and deployed:

• Storage Host Agent Extension (SHA)

• Database Scanner for Oracle

• SE Connector

Host storage supply chain information is discovered and collected by a Storage Host Agent Extension 
(SHA) in Storage Visibility and Automation. Storage asset information is discovered in Storage Essentials 
(SE) and then collected by Storage Scanners in Storage Visibility and Automation. This document explains 
how to install, configure, deploy, and manage Storage Host Agent Extensions and Storage Scanners in 
Storage Visibility and Automation.

• Information about a host storage supply chain is provided by a Storage Host Agent Extension (SHA). 
See Storage Host Agent Extension (SHA) on page 27 for more information about this component.

• Information about Oracle storage configurations in a SAN or Network Attached Storage (NAS) is 
collected by a component in Storage Visibility and Automation called the Database Scanner for Oracle. 
This Storage Scanner retrieves data about Oracle instance, tablespaces, and datafiles. See Database 
Scanner for Oracle on page 29 or Storage Scanner Configuration and Operation on page 38 for 
more information about this component.

• Information about storage arrays, switches, fabrics, and NetApp filers in your environment is 
collected by a component in SA called SE Connector. SE Connector retrieves data about the SAN 
infrastructure from SE. This storage data is transferred to the SA core and stored in the Model 
Repository. See SE Connector on page 17 or Storage Scanner Configuration and Operation on 
page 38 for more information about this component.

This guide is intended for system administrators and server administrators who are responsible for 
installing and configuring Storage Visibility and Automation. This documentation assumes that you are 
familiar with the operating systems on which this feature will be installed. It is also assumed that you have 
the required permissions to install this software on managed servers.

See the SA Standard/Advanced Installation Guide for information about how to install and configure 
Server Automation. See the SA User Guide: Application Automation for information about Service 
Automation Visualizer. See the SAR User Guide for information about Service Automation Reporter. See 
the Storage Essentials Installation Guide for information about how to install and configure Storage 
Essentials.
9
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2 Installation & Deployment
The following table identifies the storage components for Storage Visibility and Automation that must be 
installed and deployed. This table also identifies the source required to install each storage component.

The SHA, SE Connector, and Database Scanner for Oracle storage components are part of the Agent and 
Utilities DVD, which is commonly known as the upload media. These storage components are part of the 
Software Repository - Content in the upload media. The upload media contains the agents and 
utilities, such as the OS Provisioning Boot Agent, Agents for various operating systems, and so on. After 
the Server Automation (SA) core has been installed, these agents and utilities must be uploaded to the 
Software Repository.

When the Storage Visibility and Automation installation process is completed, you will have the following 
storage components in your SA core: 

• Storage Host Agent Extension (SHA)

• Database Scanner for Oracle

• SE Connector

See Storage Host Agent Extension (SHA) on page 27, Database Scanner for Oracle on page 29, and SE 
Connector on page 17 for more information about these storage components.

Installation Transcript Example

The following is an example of the BSA Installer transcript that shows the sequence of user actions 
required to install the SHA and Database Scanner for Oracle storage components.

Welcome to the Opsware Installer.
Please select the components to upgrade.
1 ( ) Software Repository - Content (install once per mesh) [UP TO DATE]
2 ( ) OS Provisioning Linux Media Verification
Enter a component number to toggle ('a' for all, 'n' for none).
When ready, press 'c' to continue, or 'q' to quit.

Selection:

table 1 Required Storage Components

Storage Component Installation Source

Storage Host Agent Extension (SHA) Agent and Utilities DVD

Database Scanner for Oracle Agent and Utilities DVD

SE Connector SE Connector
11



The SHA and Database Scanner for Oracle storage components are explicitly not shown in this example 
because they are included in the Software Repository - Content. These storage components are 
installed, upgraded, or uninstalled along with other Software Repository components.

During the installation process, the BSA Installer saves all transcript answers in a response f ile and 
provides the name and location of the response file. 

For future use, specify the name of this response file to upgrade the Software Repository. When you 
specify the name of the response file, you do not need to repeatedly answer the same transcript 
questions.

When the Software Repository - Content is installed, you will have the following storage 
components in your SA core: 

• Storage Host Agent Extension (SHA)

• Database Scanner for Oracle

See Storage Host Agent Extension (SHA) on page 27 and Database Scanner for Oracle on page 29 for 
more information about these storage components.

Storage Host Agent Extension (SHA)

For SHA, the installation process creates a server module named com.opsware.storage.storex in 
the /Opsware/Tools/Server Modules/ folder. Typically, you will not have permission to access this 
server module.

You can access SHA (which is internally known as storex) by creating a snapshot specification for storex. 
This process is standard for any server module snapshot. 

See Storage Host Agent Extension (SHA) on page 27 for more information about this storage 
component.

Database Scanner for Oracle

For the Database Scanner for Oracle, the installation process creates the following:

• An APX module named APX Oracle database scanner in the /Opsware/Storage/Tools/
DbScanner folder. 

• A server module named com.opsware.server.module.storage.dbscanner.oracle in the 
/Opsware/Tools/Server Modules/ folder.

• An ASAS Agent named OracleDBScanner that provides a user interface for viewing and managing 
the login credentials.

• A secured namespace named OPSW_SCANNER_ORACLE_INSTANCE for login credentials. 

This installation process also configures metadata that is used for the login credentials. To support 
different locales, this metadata is stored as a UTF-8 string.
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SE Connector

The following processes are required to get the SE Connector executable to a managed server:

• The installation process prepares packages and software policies in the core. 

• The deployment process copies the binaries to a managed server and then configures them. 

Prerequisites

Server Automation 7.80 or later and Storage Essentials 6.1.1.x or later are required to install, configure, 
and deploy SE Connector.

Attaching and Remediating the SE Storage Scanner and SE 
Connector Update Policies

This section describes the steps to follow when you attach and remediate the SE Storage Scanner 
and SE Connector Update policies.

To attach and remediate:

1. Attach the software policy SE Storage Scanner to the managed server.

2. Remediate the server.

3. If your HP Storage Essentials management server is version 6.1.1, you do not need to 
follow any more steps.

4. If your HP Storage Essentials management server is version 6.2 or later, attach the 
software policy SE Connector Update for your version to the managed server.

Note: The version of the SE Connector Update must be compatible with the version of the Storage 
Essentials server, which means that the version numbers of the SE Connector Update libraries 
must be the same as the version of the Storage Essentials. For example, if you have SE 6.2, 
installed, you must install the SE Storage Scanner first, then install the SE Connector Update for 
SE 6.2.

Installation Process

The installation process creates the following:

• An /Opsware/Storage/Agents/SE folder that contains all required packages for SE Connector 
and software policies for all versions of SE Client Library. Based on the operating system, the 
following two types of packages are uploaded to the SE folder:

OPSWsa-se-<OS>-xx.x.x.x.xx.zip

This file contains the SE Connector code (binaries) for a certain operating system (<OS>).
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Examples:

OPSWsa-se-linux-40.0.0.0.94.zip

OPSWsa-se-solaris-40.0.0.0.94.zip

OPSWsa-se-win-40.0.0.0.94.zip

OPSWsa-seclient-x.x.x.x-<OS>.zip

This file contains the default SE Client Library for a certain operating system (<OS>).

Examples:

OPSWsa-seclient-9.4.0.242-linux.zip

OPSWsa-seclient-9.4.0.242-solaris.zip

OPSWsa-seclient-9.4.0.242-win.zip

For each supported operating system, the installation process prepares two packages in the SE folder. The 
examples above show packages for Linux, Solaris, and Windows operating systems.

• A software policy named SE Storage Scanner in the /Opsware/Storage/SE folder.

• A software policy named SE Connector Update for <SE version> in the /Opsware/
Storage/SE Connector Updates folder.

• Several common packages in the /Opsware/Storage/Agents folder.

You must install the SE Connector Update software policy before you uninstall the SE Storage 
Scanner software policy.

See SE Connector on page 17 for more information about this storage component.

Deployment Process

In the deployment process, the administrator selects the software policy for SE Connector and assigns 
managed servers to it. During deployment, all relevant packages are copied to a managed server and all 
pre- and post-install scripts are executed. To complete the deployment process, SE Connector must be 
configured and then (automatically) started. 

To deploy SE Connector on a managed server: 

1 In the navigation pane, select Library  >  By Folder.

2 Select Opsware  >  Storage  >  Agents  >  SE to open the SE folder.

3 Open the “SE Storage Scanner” software policy. 

4 (Optional) Modify the post-install script. See Modifying a Post-install Script on page 15.

5 In the Views pane, select Server Usage.

6 Select Actions  >  Attach Server.

7 In the Attach Server dialog, select All Managed Servers to view a list of servers that meet the 
qualifications for an SE Scanner.

8 In the Attach Server content pane, select a managed server and then click Attach. 

9 Complete the Attach Server wizard.

10 Wait until the job completes.
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11  If the HP Storage Essentials management server is version 6.1.1, you do not need to follow any more 
steps.

12  If the HP Storage Essentials management server is version 6.1.1 or later, attach the software policy 
SE Connector Update for your version to the managed server:

a In the navigation pane, select Library  >  By Folder.

b Select Opsware  >  Storage  >  Agents  >  SE Connector Updates to open the folder.

c Open the SE Connector Update for <version> software policy.

d Attach and remediate.

When remediation is finished, SE Connector is configured and running on the specified managed 
server.

The version of the SE Connector Update must be compatible with the version of the Storage Essentials 
server. This means that the version numbers of the SE Connector Update libraries must be the same as the 
version of the Storage Essentials. For example, if you have Storage Essentials 6.1.1 installed, you will have 
to install the SE Storage Scanner first, and then install the SE Connector Update for 6.1.1 and later.

Modifying a Post-install Script

If port 7050 or port 7034 (the default) are not available on the managed server, you must modify the 
post-install script of the main package of SE Connector (for the corresponding operating system). 
Post-install scripts are executed after the package is copied and unpacked on the managed server. 

To modify a post-install script:

1 Open the “SE Storage Scanner” software policy.

2 In the Views pane, select Policy Items.

3 Select a package with a name similar to “OPSWsa-se-linux-40.0.0.0.94.zip”. This name must match 
the operating system name of the managed server.

4 Right-click and then select Open to display the package Properties. 

5 Expand “Install Scripts” and then select the “Post-Install Script” tab.

6 In the script, find the USER PARAMETERS section, such as 

################# USER PARAMETERS ################
SRQST_JNP_PORT=7050
HTTP_PORT_VALUE=7034
################# USER PARAMETERS ################

7 Change the value(s) and then save the package. 

Deployed Components

The following filesystem layouts identify deployed storage components, by operating system.

Unix-like Operating System

/etc/opt/opsware/pam-se .. config files
/etc/opt/opsware/startup/pam-se start|stop|status
 
/opt/opsware/pam-se

bin ............... start/stop scripts
lib ............... jar-files, third party libraries
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jboss ............. 
clientlib ......... common folder for all supported SE Client libs

/opt/opsware/pam-common/
lib   ............. common libraries (netmux.pyc)
jdk   ............ 
   

/var/log/opsware/pam-se/ ... log-files

/var/opt/opsware/pam-se
data  ............. Full sync
security .......... DeviceAccessControls
requests .......... ServiceRequests   OPTIONAL

Windows Operating System

%ProgramFiles%\Opsware\pam-se
bin ............... start/stop scripts
lib ............... jar-files, third party libraries
jboss ............. 
clientlib ......... common folder for all supported SE Client libs
          

%ProgramFiles%\Common Files\Opsware\etc\pam-se ... config
%ProgramFiles%\Common Files\Opsware\log\pam-se ... log-files OPTIONAL
%ProgramFiles%\Common Files\Opsware\pam-se

data  ............. Full/sync
security .......... DeviceAccessControls
requests .......... ServiceRequests    OPTIONAL

%ProgramFiles%\Common Files\Opsware\pam-common ... 
lib    ............ common libraries (netmux.pyc)
jdk    ............ 
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3 SE Connector
SE Connector is the Storage Scanner that collects data from Storage Essentials (SE) about SAN elements 
and inventory, and their connectivity. These SAN elements include storage arrays, fabrics, switches, and 
NAS filers. 

Prerequisites

Server Automation 7.80 or later and Storage Essentials 6.1.1.x or later are required to install, configure, 
and deploy SE Connector.

You must also authorize SE Connector before using it. Authorization enables SE Connector to accept 
different requests, such as start and stop. See Authorizing a Storage Scanner on page 39. 

The identity of this Storage Scanner is defined by HP Server Automation Agent properties. This identity is 
not changed until the Storage Scanner is restarted. This means that you must always stop the Storage 
Scanner before an SA Agent is reinstalled on a server. See Starting a Storage Scanner on page 39, 
Stopping a Storage Scanner on page 40, and Reassigning a Deployed SE Connector on page 20.

Attaching and Remediating the SE Storage Scanner and SE 
Connector Update Policies

This section describes the steps to follow when you attach and remediate the SE Storage Scanner 
and SE Connector Update policies.

To attach and remediate:

1 Attach the software policy SE Storage Scanner to the managed server.

2 Remediate the server.

3 If your HP Storage Essentials management server is version 6.1.1, you do not need to follow any more 
steps.

4 If your HP Storage Essentials management server is version 6.2 or later, attach the software policy SE 
Connector Update for your version to the managed server.

Note: The version of the SE Connector Update must be compatible with the version of the Storage 
Essentials server, which means that the version numbers of the SE Connector Update libraries 
must be the same as the version of the Storage Essentials. For example, if you have SE 6.2, 
installed, you will have to install the SE Storage Scanner first, then install the SE Connector 
Update for 6.2.
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Access Controls

The SE Connector Storage Scanner uses access controls to communicate with an instance of Storage 
Essentials for collecting information about SAN array, switch, fabric, and NetApp filer inventory. 

To create an access control for SE Connector, the following information is required: 

• IP address of the host where Storage Essentials is running

• Username of an existing user in Storage Essentials  

• Password for the existing user in Storage Essentials 

Do not collect the same set of devices from the same instance of Storage Essentials from different access 
controls.

1 In the Views pane, select Management Console.

2 Expand SE and then expand Access Controls. 

3 Select List to display the access controls for SE Connector.

Creating Access Controls for SE Connector

To create access controls for SE Connector:

1 In the navigation pane, select Administration  >  Storage Scanners.

2 In the content pane, select a Storage Scanner and then select Actions  >  Open.

3 In the Views pane, select Management Console.

4 Expand SE and then expand Access Controls. 

5 Select Create New to open the Create Access Control dialog for the SE Connector.

6 Enter values for the access control in the following fields:

Caption: A unique name that identifies the access control. 

The Caption name must be unique and cannot contain spaces or the following symbols: \s\/:*?"<>| 
!@#$%^&\\. If an existing (duplicate) name is used to create an access control, the new access control 
properties will replace (overwrite) the existing access control properties.

Host Address: IP or DNS hostname of the SE Central Management Server (CMS)

User Name: The user name required to access the devices in SE

Password: Corresponding password
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Or, for an HP Storage Essentials server that is integrated with HP Systems Insight Manager (SIM), 
enter values for the access control in the following fields:

Host Address: IP or DNS hostname of the HP Systems Insight Manager server

User Name: The user name required to access the devices in SIM and SE. 

Syntax: domain-name\username

Where "domain-name" is the name of the server where the user is created or the domain of the 
user "username" is the name of the user who has access to the devices to collect with this 
Scanner.

Password: Corresponding password

7 Click Create Access Control.

Creating Multiple Access Controls to One Instance of Storage Essentials

You can configure multiple SE Connectors communicating to one instance of Storage Essentials; however, 
each access control must be configured to collect a unique set of devices from the Storage Essentials 
instance. This is done by first configuring users in Storage Essentials, each with restricted access to a 
unique set of storage devices. Then create each access control with a different user. The access control will 
collect only those devices that the individual user can access.

Configure users in Storage Essentials, each with restricted access to unique sets of storage devices. See 
the Storage Essentials SRM Software User Guide for information about adding users and adding them to 
roles and organizations.

To create access controls for SE Connector:

1 In the navigation pane, select Administration  >  Storage Scanners.

2 In the content pane, select a Storage Scanner and then select Actions  >  Open.

3 In the Views pane, select Management Console.

4 Expand SE and then expand Access Controls. 

5 Select Create New to open the Create Access Control dialog for the SE Connector.

6 Enter values for the access control in the following fields:

Caption: A unique name that identifies the access control. 

The Caption name must be unique. If an existing (duplicate) name is used to create an access control, the 
new access control properties will replace (overwrite) the existing access control properties.

Host Address: IP or DNS hostname of the SE Central Management Server (CMS)

User Name: User name required to access the unique set of devices in SE

Password: Corresponding password

7 Click Create Access Control.
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Viewing Storage Essentials Servers for SE Connector

To view the access controls and information about all Storage Essentials servers that an SE Connector 
communicates with:

1 In the navigation pane, select Administration  >  Storage Scanners.

2 In the content pane, open a Storage Scanner.

3 In the Views pane, select Storage Essentials.

Viewing Storage Essentials Servers Managed Elements for SE Connector

To view a list of managed elements discovered by each access control for the SE Connector:

1 In the navigation pane, select Administration  >  Storage Scanners.

2 In the content pane, open a Storage Scanner.

3 In the Views pane, select Storage Essentials.

4 Select an access control in the right pane. The list of managed elements discovered by that access 
control displays in the bottom pane.

Reassigning a Deployed SE Connector

To reassign a managed server that has a deployed SE Connector (Storage Scanner) running on it to 
another core:

1 Save all access controls on the managed server to a temporary folder. Access controls are stored on 
the managed server where SE Connector is running. Based on the operating system running on the 
managed server, these access controls are located in the following directories:

On Unix: /var/opt/opsware/pam-se/security

On Windows: %ProgramFiles%\Common Files\Opsware\pam-se\security
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2 Undeploy SE Connector from the managed server in Core A. See Uninstalling SE Connector from a 
Managed Server on page 23.

3 Deploy SE Connector on the managed server in Core B. See Deployment Process on page 14.

4 Authorize the Storage Scanner in Core B. See Authorizing a Storage Scanner on page 39.

5 Stop the Storage Scanner. See Stopping a Storage Scanner on page 40.

6 Copy the access controls that you saved in step 1 on page 20.

7 Start the Storage Scanner. See Starting a Storage Scanner on page 39.
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4 Uninstallation & Undeployment
You can uninstall or undeploy storage components as follows: 

• Uninstalling Components from a Core

• Uninstalling SE Connector from a Managed Server

• Removing SE Connector from the Model Repository

• Uninstalling the Database Scanner for Oracle

Uninstalling Components from a Core

SHA and Database Scanner for Oracle Components

To uninstall the SHA and Database Scanner for Oracle storage components, run the BSA Installer 
uninstall_opsware.sh script. This script is part of the upload media. It is not part of the primary 
media. You cannot individually uninstall these storage components because they are part of the upload 
media. This action uninstalls the SHA and Database Scanner for Oracle storage components, including all 
Software Repository components. This script does not uninstall SE Connector from a core because SE 
Connector is not part of the upload media.

You are not required to remove the SE Connector component from a core. If you find that it is necessary to 
remove this component from a core, contact HP Software Support for assistance.

Uninstalling SE Connector from a Managed Server

When you uninstall SE Connector from a managed server, the access controls and discovered data are 
deleted from the managed server. Uninstalling SE Connector from a managed server is also known as 
undeploying SE Connector from a managed server. You would typically undeploy SE Connector from a 
managed server when you need to repurpose that server. Because SE Connector implements common SA 
features (such as software policy and remediation) that are independently controlled by the user 
interface, you can selectively uninstall this storage component without affecting any other storage 
component.

If you need the existing configured access controls for future use, be sure and save them before detaching 
the managed server from SE Connector. When you detach the server from the software policy, all SE 
Connector binaries and data will be removed from the managed server.

To uninstall (undeploy) SE Connector from a managed server: 

1 In the navigation pane, select All Managed Servers.

2 Select the server that you want to undeploy SE Connector from.
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3 From the View drop-down list, select Software Policies.

4 In the lower Software Policies pane, select the SE Connector Update software policy.

You must uninstall the SE Connector Update software policy before you uninstall the SE 
Storage Scanner software policy.

5 Right-click and then select Detach.

6 In the Detach Software Policy dialog, click Detach.

7 In the Remediate dialog, confirm your selection and then run or schedule the job.

8 Wait until the job completes.

9 In the lower Software Policies pane, select the SE Storage Scanner software policy.

You must uninstall the SE Connector Update software policy before you uninstall the SE 
Storage Scanner software policy.

10 Right-click and then select Detach.

11 In the Detach Software Policy dialog, click Detach.

12 In the Remediate dialog, confirm your selection and then run or schedule the job.

13 Wait until the job completes.

Or

1 In the navigation pane, select Library  >  By Folder.

2 Select Opsware  >  Storage  >  Agents  >  SE Connector Updates to open the folder.

3 Open the SE Connector Update for <version> software policy.

4 Detach and remediate.

5 Select Opsware  >  Storage  >  Agents  >  SE to open the SE folder.

6 Open the “SE Storage Scanner” software policy.

7 In the Views pane, select Server Usage.

8 In the Server Usage content pane, select a managed server, right-click, and then select Detach Server. 

9 Click Detach to start the job and then wait until the job completes.

Removing SE Connector from the Model Repository

When you remove SE Connector, its entry is removed from the Model Repository. 

This operation applies only to SE Connector. It does not apply to the Database Scanner for Oracle.

To remove SE Connector:

1 In the navigation pane, select Administration  >  Storage Scanners.

2 In the content pane, select SE Scanner on <system name>.

3 Right-click and then select Remove.
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Uninstalling the Database Scanner for Oracle

The Database Scanner for Oracle component is uninstalled by running the BSA Installer 
uninstall_opsware.sh script. 

During the uninstall process, you will be asked whether configured login credentials should be preserved. 
If you are planning to install the Software Repository again and repeat discovery for the same databases, 
it is recommended that you preserve these login credentials. When you confirm that you want to keep 
these credentials, the uninstall process continues without removing them.

To uninstall the Database Scanner for Oracle:

1 Insert the upload media.

2 Run the BSA Installer opsware_installer/uninstall_opsware.sh script.

3 Select Software Repository - Content and start the uninstall process. This process removes 
the Database Scanner for Oracle component.
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5 Storage Host Agent Extension (SHA)
Storage Host Agent Extension (SHA) is a Server Automation (SA) server module that manages host 
storage. SHA provides the Web Services Data Access Engine with information about a host storage supply 
chain. This information includes, but is not limited to, the following artifacts:

• Fabric channel HBA assets—adapters and ports

• Fabric channel HBA devices—targets and logical units

• Disk devices—block, raw, and partitions

• Multipath I/O (MPIO) assets, configuration, and devices

• Volume manager (VM) assets, configuration, and devices

• Filesystems

This storage information is collected by a snapshot specification that you create.

See the Storage Visibility and Automation Release Notes for a list of operating systems SHA supports.

Prerequisites

The HP Server Automation(SA) core must be running when you install the SHA distribution. See the SA 
Simple/Advanced Installation Guide for information about installing and configuring an SA core.

Before installing a Storage Host Agent Extension (SHA) on an HP-UX system, verify that the operating 
system has all available updates and patches installed.

Upgrading a Storage Host Agent Extension

SHA is upgraded when an administrator needs to install SHA on an SA core that already contains an SHA 
module. 

Before starting the upgrade process, verify that there are no storage inventory snapshot jobs running.

During the upgrade process, the HP BSA Installer removes all previous versions of the SHA module from 
the SA core before installing the new version. All existing snapshot specifications remain unchanged and 
are ready for execution with the upgraded SHA module.

To upgrade SHA on an SA core, use the upgrade_opsware.sh command.

To upgrade SHA on a managed server, use the SAS Web Client or run a Storage Inventory snapshot.
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Creating a Storage Inventory Snapshot for Host & VMware 
Servers

You can create storage inventory snapshots for host (SHA) servers and VMware ESX and ESXi servers. SHA 
is a server module that you run on a managed server (or group of servers) by creating a snapshot 
specification that includes storage inventory information. VMware is part of the storage inventory 
snapshot for Unix operating systems, where the target is an ESX or ESXi server. 

In addition to creating storage inventory snapshots of an ESX server, you also need to create snapshots 
for all associated virtual machines defined on that ESX server in order to collect complete storage supply 
chain information for the machines. File system data for ESX and ESXi servers is not collected.

To create a snapshot specification:

1 In the navigation pane, select Library  >  By Type  > Audit and Remediation  >  Snapshot 
Specifications.

2 In the expanded Snapshot Specifications folder, select the operating system that you are creating the 
snapshot specification for—Windows or Unix. For ESX hypervisors, select Unix.

3 From the Actions menu, select New to display the Snapshot Specification Properties window.

4 Enter a name for the storage inventory snapshot.

5 (Optional) Enter a description for the inventory snapshot.

6 Verify that the Perform Inventory option is checked. The default is unchecked.

7 In the Views pane, select Targets to display the Snapshot Specification Targets window.

8 Click Add to add the hosts or host groups that are to be included in the storage inventory snapshot.

9 In the Views pane, select Rules  >  Storage to display the Snapshot Specification Rules Storage 
window. 

10 To request an Inventory snapshot, select Inventory in the Available for Snapshot Specification section.

11 Click the + >> button to move Inventory to the Selected for Snapshot Specification section.

12 From the File menu, select Save or press Ctrl-S.

13 From the Actions menu, select Run Snapshot Specification.

14 Continue advancing through the Run Snapshot Specification steps until the job completes. 

15 Click Close to close the Job Status window.

See the Storage Visibilty and Automation User Guide for more information about Storage Host Agent 
Extension (SHA) and VMware ESX and ESXi support.
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6 Database Scanner for Oracle
The Database Scanner for Oracle collects data about Oracle storage configurations in a SAN or Network 
Attached Storage (NAS), such as the Oracle instance, tablespaces, and datafiles. 

Storage elements configured for an Oracle instance can be classified as physical database storage and 
logical database storage:

— Physical database storage includes datafiles and redo logs that directly consume system 
storage resources (filesystems or partitions) or are built on top of ASM Files. 

— Logical database storage includes entities such as tablespaces that are created inside the 
instance consuming different physical and logical storage entities. 

This Storage Scanner identifies relationships between the database elements and other storage assets as 
described in Table 1.

See Storage Scanner Configuration and Operation on page 38 for information about managing the 
Database Scanner for Oracle.

This section describes the following prerequisites for setting up the Database Scanner for Oracle:

• Permissions

• Hardware Registration for the Model Repository

• Login Credentials

table 1 Database Assets & SAN Relationships

Database Asset External Storage Asset Dependency Description

SAN-based physical 
database storage

Server assets
SAN array assets
Fabric assets
Switch assets

Block storage 
dependency

Provides the dependency chain 
between the database storage 
elements and SAN arrays through 
system (server) resources and 
fabrics. 

NAS-based physical 
database storage

Server assets
NetApp assets

NAS storage 
dependency

Provides the dependency chain 
between the database storage 
elements, server resources, and 
NetApp.
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Permissions

IMPORTANT: In order to monitor an Oracle 11G database with the SA Oracle Database Scanner, the XML DB 
and DBMS_NETWORK_ACL_ADMIN packageS must exist in the database. The SA Oracle DB Scanner needs 
access to these objects in order to grant privileges and access for itself. If the objects do not exist, then the 
pamuserprivilege.sql will fail and the DB Scanner cannot be run. An application may or may not 
install these objects in its Oracle 11G database. 

The following error might be displayed under these circumstances: 

PLS-00905: object SYS.DBMS_NETWORK_ACL_ADMIN is invalid. 

Before executing the SA DB Scanner pamuserprivilege.sql in the Oracle database, first perform the 
following steps to install the XML DB and DBMS_NETWORK_ACL_ADMIN package in the Oracle 11G 
database. 

1 cd $ORACLE_HOME/rdbms/admin

2 sqlplus /nolog

3 SQL> connect <sys_user>/<password> as sysdba

4 SQL> spool install_xml.log

5 SQL> @catqm xdb sysaux temp NO

6 SQL> @dbmsnacl.sql

7 SQL> spool off;

You must run the pamuserprivilege.sql script on each database to be scanned before the Database 
Scanner for Oracle can scan the inventory of the given database. The script creates a database account 
with read-only access to the schema objects required by the scanner. This script is installed along with the 
APX and is accessible in OGFS.

The pamuserprivilege.sql script is located in the following OGFS folder:

/opsw/apx/runtime/script/com.opsware.server.module.storage.dbscanner.oracle 

See the SA User Guide: Server Automation for more information about OGFS.

To run the DBScanner snapshot on managed servers:

1 Run the Storex snapshot on the target managed server, where you configured the database instance.

2 Create and run the DB Scanners Snapshot - the run will fail at this time, but it will import the SQL 
scripts pamuserprivilege.sql, configureXMLDB.sql andconfigureXMLDB_Windows.sql.

3 Connect to the target managed server and execute the following commands.

Linux: cd /opt/opsware/dbscanner.oracle/lib/
Windows: cd C:\Program Files\Opsware\dbscanner.oracle\lib

4 (Linux) Change the script permissions:

chmod 777 *
su – oracle

5 Connect to sqlplus and run the following commands and scripts:

$sqlplus / as sysdba
SQL>@configureXMLDB.sql (For Linux)
SQL>@configureXMLDB_Windows.sql (For Windows)
SQL>@pamuserprivilege.sql
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6 Navigate to Administration Panel > Storage Scanner > Oracle DBScanner > Add login credentials.

7 Add the targeted managed server name mentioned in Step 1 and provide the database instance name 
(SID).

8 Rerun the DB Scanner snapshot you ran earlier. 

Storage Host Agent Extension
Before running database discovery, a snapshot of the Storage Host Agent Extension (SHA) must be 
created for the managed server where the Oracle instance or database is.

Hardware Registration for the Model Repository
You must perform a hardware registration with the Model Repository so that the Storage Scanner 
(Database Scanner for Oracle) is able to collect information about Oracle databases. For more information 
about hardware registration, see SA User Guide: Server Automation.

Login Credentials

This section describes the login credentials for each database instance that the Database Scanner for 
Oracle will manage. A login credential contains values that direct the Database Scanner for Oracle to 
where a specific instance resides. Table 2 describes the login credentials you must create before running 
the Database Scanner for Oracle for the first time.  

Viewing & Creating Login Credentials

Login credentials are parameters that allow the Database Scanner for Oracle to connect to databases and 
run queries that discover software application storage. 

table 2 Database Scanner for Oracle Login Credentials

Login Credential Description

Caption An arbitrary name that identifies the login credential. 
The default is Oracle LoginCredential.

User Name The Oracle user name that is authorized to access the 
Oracle database. The default is oraclepam.

User Password The Oracle password that is authorized to access the 
Oracle database.The default is pam.

Oracle System ID A unique name that identifies an Oracle instance on a 
managed server. This ID is provided by the database 
administrator.

Port The TCP port that the Oracle listener uses. The Storage 
Scanner communicates with the Oracle instance through 
this port. The default is 1521.
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To view or modify information about the login credentials for the Database Scanner for Oracle or to add 
or delete credentials:

1 From the navigation pane, select Administration  >  Storage Scanners.

The OracleDBScanner window is displayed.

2 In the content pane, open a Database Storage Scanner for Oracle.

3 From the Views pane, select Login Credentials.

4 In the content pane, select a server.

5 (Optional) Select a credential and then right-click and select one of the following options:

• Add Credential

• Edit

• Delete

Viewing Login Credentials for a Server

To view the login credentials for a managed server:

1 From the navigation pane, select Administration  >  Storage Scanners.

2 In the content pane, open a Database Storage Scanner for Oracle.

3 From the Views pane, select Login Credentials. The content pane lists the managed servers that have 
at least one or more login credentials created. This list will be empty if there are no login credentials 
configured for any of the managed servers. An empty list is typical and expected when Storage 
Visibility and Automation has just been installed or upgraded in a datacenter.

Creating a Database Scanner Storage Inventory Snapshot

A Database Scanner for Oracle storage inventory snapshot can be scheduled or manually started. During 
the snapshot process, login credentials for every managed server specified in the snapshot are retrieved. 
The snapshot executes discovery for all of these login credentials.
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An SHA storage inventory snapshot is required before you create a database storage inventory snapshot. 
See Creating a Storage Inventory Snapshot for Host & VMware Servers on page 28 for more 
information.

To create a snapshot specification:

1 From the navigation pane, select Library  >  By Type  > Audit and Remediation  >  Snapshot 
Specifications.

2 From the expanded Snapshot Specifications folder, select the operating system that you are creating 
the snapshot specification for—Windows or Unix.

3 From the Actions menu, select New to display the Snapshot Specification Properties window.

4 Enter a name for the inventory snapshot.

5 (Optional) Enter a description for the inventory snapshot.

6 Verify that the Perform Inventory option is checked. The default is unchecked.

7 From the Views pane, expand Targets and then specify one or more targets.

8 Click Add to add the hosts or host groups that are to be included in the inventory snapshot.

9 From the Views pane, select Rules  >  Database Scanner for Oracle to display the Snapshot 
Specification Rules Storage window. 

10 To request an Inventory snapshot, select Inventory in the Available for Snapshot Specification section.

11 Click the + >> button to move Inventory to the Selected for Snapshot Specification section.

12 From the File menu, select Save or press Ctrl-S.

13 From the Actions menu, select Run Snapshot Specification.

14 Continue advancing through the Run Snapshot Specification steps until the job completes. 

A successful snapshot job is one where all discoveries are successfully completed (Succeeded). If any 
discovery fails, the snapshot job status will indicate a failure. If there are no login credentials created 
for a managed server, the snapshot job status will be reported as Failed.

15 Click Close to close the Job Status window.
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7 Administration
This section explains the user permissions required to view storage devices and related information, and 
how to manage the Storage Scanners.

Server Automation (SA) Permissions
SA permissions allow users to view storage devices and related data. Table 3 specifies the permissions 
required by users to perform specific actions in the Storage Visibility and Automation feature. For storage 
administrators, this table answers the question: To perform a particular action, what permissions does a 
user need?

In Table 3, most of the entries in the User Action column correspond to menu items in the SA Client. In 
addition to feature permissions, server permissions are required on the managed servers affected by the 
storage discovery operation. 

table 3 Storage Visibility and Automation Permissions Required for User Actions

User Action Required Feature
Required 
Permissions

Storage Systems

Manage Storage Systems Manage SE Storage Scanner Read & Write

View Initiator Dependencies for Storage Systems Manage SE Storage Scanner Yes

View Target Dependencies for Storage Systems Manage SE Storage Scanner Yes

View Fabric Dependencies for Storage Systems Manage SE Storage Scanner Yes

Manage Public Device Group Manage SE Storage Scanner Yes

Start Inventory Scan Manage SE Storage Scanner Yes

View information for a storage array/NAS Filer Manage SE Storage Scanner Read

View inventory for a storage array/NAS Filer Manage SE Storage Scanner Read

Modify properties of a storage array/NAS Filer, 
such as updating a caption for a storage array/
NAS Filer 

Manage SE Storage Scanner Read & Write

Delete (remove) a storage array/NAS Filer Manage SE Storage Scanner Yes

Fabrics 

Manage Fabrics Manage SE Storage Scanner Read & Write

View Server Dependencies for Fabrics Manage SE Storage Scanner Yes

View Storage Dependencies for Fabrics Manage SE Storage Scanner Yes

Manage Public Device Group Manage SE Storage Scanner Yes
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Start Inventory Scan Manage SE Storage Scanner Yes

Application Storage Automation System

Manage DB Scanner Manage SE Storage Scanner Yes

Manage Fabric Agent Manage SE Storage Scanner Yes

Manage Storage Agent Manage SE Storage Scanner Yes

Authorize SE Connector Manage SE Storage Scanner Yes

Start SE Connector Manage SE Storage Scanner Yes

Stop SE Connector Manage SE Storage Scanner Yes

Create access controls for SE Connector Manage SE Storage Scanner Read & Write

Modify login credentials for the Database 
Scanner for Oracle

Manage Database Agent Read & Write

Issue a synchronization request Manage SE Storage Scanner Yes

Remove (unauthorize) SE Connector Manage SE Storage Scanner Yes

Checking the current state of SE Connector Manage SE Storage Scanner Yes

Modifying the settings for SE Connector Manage SE Storage Scanner Yes

View information for a database Manage Databases Read

View inventory for a database Manage Databases Read

Modify properties of a database, such as 
updating a caption for a database

Manage Databases Read & Write

Delete (remove) a database Manage Databases Read & Write

Add a storage array/NAS Filer to a Public Device 
Group

Manage Public Device Group 
(Storage Systems)

N/A

Add a storage array/NAS Filer to a Public Device 
Group

Manage Public Device Group 
(Storage Systems)

N/A

View relationships of servers consuming storage 
using the fabrics/storage switches in a storage 
data path

View Fabric Dependencies for 
Servers

Read

View relationships for servers consuming 
storage from storage arrays/NAS Filers

View Storage Supply Chain 
for Servers

Read

View relationships between storage arrays/NAS 
Filers and servers 

View Server Dependencies 
for Storage Systems

N/A

table 3 Storage Visibility and Automation Permissions Required for User Actions (cont’d)

User Action Required Feature
Required 
Permissions
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In addition to the feature permissions listed in Table 3, every user action also requires the Managed 
Servers and Groups feature permission.

A user or user group must also have the “Manage Storage Systems” and “Manage Fabrics” permissions to 
enable corresponding “View...” storage permissions. The "View..." permissions are valid only if the user or 
user group has read permission for that resource type, such as you must have the “Manage Storage 
Systems” permission to enable the “View Server Dependencies for Storage Systems” permission. 

To run database discovery, the administrator must have the following permissions:

• Permissions to create and execute a snapshot 

• "Managed Servers and Groups" permission. This privilege is granted in the OCC Web client.

• Additional Read & Write privileges for "Customers" and "Facilities" containing the target server (the 
server that contains the Oracle database). This privilege is granted in the OCC Web client.

• "Execute" permission for the Opsware/Storage/Tools/DbScanner folder. This permission is 
granted from NGUI folder properties. The “Execute” permission must be granted through the same 
user group that has privileges for snapshot management.

• "Manage Database Scanner" permission 

By default, the Advanced Users group does not have permissions for /Opsware/Storage and underlying 
folders. Members of this group will not be able to view or use any software policies in the folders. When 
permissions for this group are granted, they are based on the corresponding Storage Visibility and 
Automation features that are assigned to that group.

For more information about users, groups, and granting permissions, see the SA User Guide: 
Application Automation.

Viewing SA Permissions

To view SA permissions: 

1 Log in to the SAS Web Client as an Administrator. 

2 In the navigation pane, select Administration  >  Users and Groups. The View Groups pane appears.

3 Click the Groups tab.

View relationships for storage arrays/NAS Filers 
providing storage using the fabrics/storage 
switches in a storage data path

View Fabric Dependencies for 
Storage Systems

N/A

View relationships between fabrics/storage 
switches in the storage data path for servers 
connected to them and consuming storage using 
them

View Server Dependencies 
for Fabric

N/A

View relationships between fabrics/storage 
switches in the storage data path for storage 
provided by storage arrays/NAS Filers

View Storage Dependencies 
for Fabric

N/A

table 3 Storage Visibility and Automation Permissions Required for User Actions (cont’d)

User Action Required Feature
Required 
Permissions
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4 Select a group. The group is displayed in the View Groups pane.

5 Click the Client Features tab.

If a user has no SA permissions, the SA Client will not display the SA Client item on the Tools menu.

Storage Scanner Configuration and Operation

Each Storage Scanner requires configuration and management tasks, such as creating access controls and 
login credentials, authorizing the Storage Scanner, starting and stopping the Storage Scanner, and 
modifying Storage Scanner settings.

To configure a Storage Scanner on a managed server, you must have read and write permission on that 
server.

See SE Connector on page 17 or Database Scanner for Oracle on page 29 for information that is specific 
to the type of Storage Scanner, such as access controls and login credentials.

Storage Scanner Settings

Storage Scanner settings (properties) manage SE Connector behavior. After you install and configure SE 
Connector (the Storage Scanner), you can adjust these settings.

You can modify the following Storage Scanner properties:

• DataManager.properties

• JmsMessenger.properties

• Logging.properties

• RequestManager.properties

• SEPlugin.properties

• StatusManager.properties

To conserve disk space, modify the maximum size of log files and the level of detail gathered for log 
messages. See Log File Settings on page 38. To tune system performance, adjust the intervals at which 
full synchronization runs.

If you need to modify thread pools, contact HP Support.

Log File Settings

To conserve disk space and control the types of log messages that Storage Visibility and Automation 
collects, you can adjust the maximum size of log files and the logging level. For troubleshooting, you can 
also adjust trace error messages.

• File Level:

— Trace-messages: FINE, FINER, FINEST, INFO, SEVERE, WARNING

— Log-messages: INFO, SEVERE, WARNING

— Error messages: SEVERE, WARNING
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• File Count: 10 (default)

• File Limit: the size of one file before rolling it out to another file

— The default for error and log files is 1MB. 

— The default for debug (trace error) messages is 10 MB.

Modify the following settings to completely switch off corresponding messages:

—  Error File Enables: True | False

—  Tracing Enabled: True | False

Authorizing a Storage Scanner

The purpose of authorization is to provide a matching pair of security tokens—one token in the core and 
the other token on the managed server where the Storage Scanner (SE Connector) is deployed. When SE 
Connector is initially deployed to a managed server, you must authorize it so that messages from the 
Storage Scanner are accepted by the core server.

To authorize a Storage Scanner:

1 From the navigation pane, select Administration  >  Storage Scanners.

2 Open the Storage Scanner that needs to be authorized.

3 From the Actions menu, select Authorize.

Starting a Storage Scanner

When the Storage Scanner (SE Connector) starts for the first time, it begins collecting storage information 
and synchronizing device data. During this process, the Storage Scanner gathers information from various 
elements and reports that information to the Web Services Data Access Engine so that the device data is 
synchronized. Depending on the size of the element, device synchronization could require several hours.

For performance reasons, it is recommended that you start the Storage Scanner during off-peak hours.

To start a Storage Scanner on a managed server:

1 In the Storage Scanners content pane, select a Storage Scanner and then select Actions  >  Open to 
display its browser.

2 Select Action  >  Start.

3 Click the “Check current state” link to verify that the Storage Scanner is Running.

The start action does not apply to the Database Scanner for Oracle.

Starting the Storage Scanner on a Remote Windows Server

To start the Storage Scanner (SE Connector) on a remote Windows managed server:

1 From the Control Panel, select Administrative Tools  >  Services.

2 In the Services window, select OpswareSEStorageScanner and then select Action  >  Start.
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Stopping a Storage Scanner

Before you modify any Storage Scanner (SE Connector) settings, you must stop the Storage Scanner. You 
should also stop and then restart the Storage Scanner after any storage element changes are made. This 
action does not interfere with any database changes that are in progress. You can stop the Storage 
Scanner by using the Storage Visibility and Automation Client on a managed server or by running a saved 
script on a remote managed server. 

After the Storage Scanner is stopped or undeployed, the status does not change.

To stop a Storage Scanner (SE Connector) on a managed server by using the Storage Visibility and 
Automation Client:

1 In the Storage Scanners content pane, select a Storage Scanner and then select Actions  >  Open to 
display its browser.

2 Select Actions  >  Stop.

3 Click the “Check current state” link to verify that the Storage Scanner is Not Running.

The stop action does not apply to the Database Scanner for Oracle.

Stopping the Scanner on a Remote Windows Server

To stop the Storage Scanner (SE Connector) on a remote Windows managed server:

1 From the Control Panel, select Administrative Tools  >  Services.

2 In the Services window, select OpswareSEStorageScanner and then select Action  >  Stop.

Checking the Storage Scanner Status

When the Storage Scanner (SE Connector) starts, it begins the collection and synchronization process.

To check the status of this process:

1 From the navigation pane, select Administration  >  Storage Scanners.

2 Select a Storage Scanner.

3 From the View drop-down list, select Properties.

4 Click the “Check current state” link in the content pane to verify that the Storage Scanner is Running 
or Not Running.

The check status action does not apply to the Database Scanner for Oracle.
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Viewing Storage Scanner Properties & Current State

To view the properties for a Storage Scanner or check the current state of a Storage Scanner:

1 From the navigation pane, select Administration  >  Storage Scanners.

2 From the View drop-down list, select Properties.

3 In the content pane, open a Storage Scanner.

4 (Optional) Select the “Check current state” link to view the most recent status of the Storage Scanner, 
such as Running or Not Running.

Viewing Storage Scanner Managed Elements

This task applies to the SE Connector (Storage Scanner) and the Database Scanner for Oracle (Storage 
Scanner). You can view managed elements collected by a Storage Scanner and managed elements 
collected by an individual access control. The managed elements collected by an access control is a subset 
of the elements collected by the Storage Scanner.

To view the managed elements collected by the Storage Scanner:

1 From the navigation pane, select Administration  >  Storage Scanners.

2 In the content pane, open a Storage Scanner.

3 From the View drop-down list, select Managed Elements.
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Customer and Facility are determined based on similar properties of the managed server where the 
Storage Scanner is running. This is the Storage Scanner that discovered the managed device, such as an 
array, NetApp filer, and so on. Fabrics are excluded from this list of managed elements. To view managed 
elements for fabrics, see the next task.

To view the managed elements (such as fabrics) collected by an individual access control:

1 From the navigation pane, select Administration  >  Storage Scanners.

2 In the content pane, open a Storage Scanner.

3 From the Views pane, select Storage Essentials.

4 In the content pane, select an access control to view.

Viewing the Storage Scanner History Log

To view the history log for a Storage Scanner:

1 From the navigation pane, select Administration  >  Storage Scanners.

2 In the content pane, open a Storage Scanner.

3 In the View drop-down list, select History.

4 In the content pane, select an event from the history log and then select the following option from the 
Actions menu:

• View Event Details—Displays detailed information about the event.

Or

• Right-click on the event and select View Event Details.

Events in the history log are reported by the Storage Scanner while performing data synchronization.
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8 Virtualization Permissions
This chapter discusses the four different kinds of permissions required to perform virtualization actions.

Actions Permissions

These permissions let you perform specific tasks, such as cloning a VM, deploying a VM from a VM 
template, and converting a VM to a VM template. Without action permissions, the corresponding menu 
items are not displayed in the Actions menu of the SA Client. For a complete list of action permissions, see 
the SA Administration Guide.

VS Container Permissions

These permissions give you access to the Virtualization Services and the containers under the VS. These 
containers can be datacenters, hypervisors, hosts, host groups, clusters, resource pools, and folders 
under the Virtualization Service

Server Resource Permissions

These permissions give you access to facilities, customers, and device groups where the VMs will run. For 
more information on server resource permissions, see the SA Administration Guide.

Folder Permissions

These permissions give you access to items in the SA Library needed by VMs such as OS Build Plans, 
patches and patch policies, software packages and software policies, application configurations, audit 
policies, and reports. For more information on folder permissions, see the SA Administration Guide.

Granting Permissions

The permissions discussed in this chapter are granted through user groups. SA provides a set of user 
groups, based on typical user roles, that are intended to help you to set up your own user groups specific 
to your environment.

User group names:

• Virtualization Administrators

• VM Lifecycle Managers

• VM Template Deployers

• VM Template Managers
43



44 Chapter 8



Index
A

Agent and Utilities DVD, 11

Attach Server wizard, 14

B
BSA Installer, 11, 12, 25

C
Caption, login credential for, 31

Central Management Server, 18, 19

CMS. See Central Management Server., 18, 19

D

database discovery, permissions required for, 37

Database Scanner for Oracle, 9, 11, 23

E

ESX hypervisors, 28

ESX servers, 28

ESXi servers, 28

F

full synchronization, 38

H

HP Systems Insight Manager, 19

hypervisors. See ESX hypervisors., 28

L

logical database storage, 29

login credentials, 25, 32

login credentials, Database Scanner for Oracle, 31

M
Model Repository, 9, 24

N

NAS. See Network Attached Storage., 9, 29

Network Attached Storage, 9, 29

O
opsware_installer/uninstall_opsware.sh script, 25

Oracle System ID, login credential for, 31

P

physical database storage, 29

Port, login credential for, 31

pre-install scripts, 14

primary media, 23

R

remediation, 23

remediation, software policy, 23

response file, 12

S

SA. See Server Automation., 11, 27

SAR. See Service Automation Reporter., 9

SAV. See Service Automation Visualizer., 9

SE Client Library, 13, 14

SE Connector, 9, 23

SE Connector Update software policy, 14, 24

SE Storage Scanner software policy, 14, 15, 24

SE. See Storage Essentials., 9

Server Automation, 9, 11, 27

Service Automation Reporter, 9

Service Automation Visualizer, 9

SHA. See Storage Host Agent Extension., 9, 12, 27, 28, 
31

SIM. See Systems Insight Manager., 19
  45



snapshot, storage inventory, 28

software policy
SE Connector Update, 14
SE Storage Scanner, 14

software policy, SE Connector, 14

software policy, SE Storage Scanner, 14, 15, 24

Software Repository, 11, 12, 25

Software Repository - Content, 11, 12, 25

Storage Essentials, 9

Storage Host Agent Extension, 9, 11, 12, 23, 27, 28, 
31, 33

storage inventory snapshot, 28

Storage Visibility and Automation, 9

storex. See Storage Host Agent Extension., 12

U
uninstall_opsware.sh script, 23, 25

upload media, 11, 23, 25

User Name, login credential for, 31

User Password, login credential for, 31

UTF-8, 12

V

virtualization, 43

VMware, 28

VMware ESX, 28

VMware ESXi, 28

W

Web Services Data Access Engine, 39

wizard, Attach Server, 14
46


	HP Server Automation
	Storage Visibility and Automation Installation & Administration Guide
	Contents
	1 Introduction
	2 Installation & Deployment
	Installation Transcript Example
	Storage Host Agent Extension (SHA)
	Database Scanner for Oracle
	SE Connector
	Prerequisites

	Attaching and Remediating the SE Storage Scanner and SE Connector Update Policies
	Installation Process
	Deployment Process
	Modifying a Post-install Script
	Deployed Components



	3 SE Connector
	Prerequisites
	Attaching and Remediating the SE Storage Scanner and SE Connector Update Policies
	Access Controls
	Creating Access Controls for SE Connector
	Creating Multiple Access Controls to One Instance of Storage Essentials
	Viewing Storage Essentials Servers for SE Connector
	Viewing Storage Essentials Servers Managed Elements for SE Connector
	Reassigning a Deployed SE Connector


	4 Uninstallation & Undeployment
	Uninstalling Components from a Core
	SHA and Database Scanner for Oracle Components

	Uninstalling SE Connector from a Managed Server
	Removing SE Connector from the Model Repository
	Uninstalling the Database Scanner for Oracle

	5 Storage Host Agent Extension (SHA)
	Prerequisites
	Upgrading a Storage Host Agent Extension
	Creating a Storage Inventory Snapshot for Host & VMware Servers

	6 Database Scanner for Oracle
	Permissions
	Storage Host Agent Extension
	Hardware Registration for the Model Repository
	Login Credentials
	Viewing & Creating Login Credentials
	Viewing Login Credentials for a Server

	Creating a Database Scanner Storage Inventory Snapshot

	7 Administration
	Server Automation (SA) Permissions
	Viewing SA Permissions

	Storage Scanner Configuration and Operation
	Storage Scanner Settings
	Log File Settings
	Authorizing a Storage Scanner
	Starting a Storage Scanner
	Starting the Storage Scanner on a Remote Windows Server

	Stopping a Storage Scanner
	Stopping the Scanner on a Remote Windows Server

	Checking the Storage Scanner Status
	Viewing Storage Scanner Properties & Current State
	Viewing Storage Scanner Managed Elements
	Viewing the Storage Scanner History Log


	8 Virtualization Permissions
	Actions Permissions
	VS Container Permissions
	Server Resource Permissions
	Folder Permissions
	Granting Permissions


	Index


